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Quick Guide 
SatSYNC is a desktop application which allows you to transfer routes, objects of interest (OOIs) and 

customised POI icons between the Active 10 and your computer. You can also use SatSYNC to upgrade 

your Active 10 Software. This section briefly describes the use of each button and menu shown in the 

main SatSYNC window (see Figure 1).  

 

Figure 1: The appearance of the main SatSYNC window when an Active 10, running the combination software version 1.4 or 
higher and platform version 21, is connected to a computer. 

Toolbar: 

 

Import – transfer supported files (.GPX, .KML, .KMZ, .LOC, .ZIP, .TXT, .PNG, .XOL, .TCX, .JPG, 

.MAP) which are on your computer to the Active 10 Internal Storage or an SD Card inserted 

in the Active 10. 

 

Import – transfer directions or shapes from Google Maps to the Active 10 
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Export – transfer files from the Active 10 Internal Storage or an SD Card to your computer. 

 

 

Refresh – refresh the contents of the current folder. When you use the Active 10 to modify 

routes or OOI, or take screenshots while it is already connected to SatSYNC, open the folder 

where the changes occurred and click on the Refresh button to see changes. 

 

Settings – set preferences concerning the names of imported routes and OOIs, the filtering 

of route points, the automatic assignment of icons to Geocaching POIs, the export of files, 

the download of data from the Internet, and the suppression of messages. 

Menus: 

 File 
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Tools 

 

 Go To – go to different websites to create, share and download routes and OOIs 

 Help 
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1 Introduction 
SatSYNC is a desktop application which allows you to transfer routes, objects of interest (OOIs) and 

customised POI icons between the Active 10 and your computer. You can also use SatSYNC to upgrade 

your Active 10 Software. You can create routes or OOIs on the Active 10 and use SatSYNC to export 

them to your computer to view/edit in other mapping tools or share with family and friends. 

You can also create or download routes and OOIs from a number of sources including: 

 Satmap Xpedition 

 Geocaching.com 

 Geocaching Australia 

 Opencaching 

 Gipfelbuch.ch 

 Google Earth 

 Google Maps 

 Waymarking.com 

When you download routes and OOIs from these or other sources to your computer, you need use 

SatSYNC to import them to your Active 10.  

1.1 Starting SatSYNC 

You can start SatSYNC before or after connecting the Active 10 to your computer, but the following 

notes account for the former scenario. To start SatSYNC, double-click on the SatSYNC desktop shortcut 

or: 

1) Click on Start 

2)  Click on All Programs 

3) Click on Satmap Systems Ltd 

4) Click on SatSYNC 

The main SatSYNC window is depicted in Figure 2. There are nine key components in the SatSYNC 

window:  

 Minimise, Maximise and Close Buttons (on the top right hand corner of the SatSYNC window): 

the Close button allows you to completely exit from SatSYNC; the Maximise button enlarges the 

http://www.satmap-xpedition.com/
http://www.geocaching.com/
http://geocaching.com.au/
http://www.opencaching.org.uk/
http://www.gipfelbuch.ch/
http://earth.google.com/
http://maps.google.co.uk/
http://www.waymarking.com/
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SatSYNC window such that it fill your entire screen; the Minimise button minimises SatSYNC to 

the icon tray normally located in the bottom right hand corner of computer screen 

 Folders Pane: displays a tree structure of the folders on the Active 10 

 Folders and Files Pane: displays folders and files in the current folder as indicated by the 

address 

 Address bar: show the folder that is currently open in the Internal Storage or SD Card 

 Toolbar: allow you to carry out various operations; if a button has been activated, i.e., if you 

click on it something will happen, it turns orange when the mouse is over it, otherwise it 

remains grey 

 Progress Bar and Cancel Button: appear during a file transfer enabling you to track the progress 

of the transfer and cancel it if necessary (see Figure 3) 

 

Figure 2: The appearance of the main SatSYNC window where there is no Active 10 connected to your computer. 
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Figure 3: The appearance of the main SatSYNC window during a file transfer. 

1.2 Connecting the Active 10 

Please ensure that your Active 10 unit contains a set of good batteries. If it does not, the unit will not 

power up correctly. The power from the USB connection is able to support the batteries in running the 

unit, but is not sufficient to run the unit by itself. 

When the Active 10 is not connected to your computer, most of the buttons are grey as illustrated in 

Figure 2. In addition, the zigzag symbol in the middle of the SatSYNC icon in the icon tray is white: . 

When you connect the Active 10 to your computer while SatSYNC is running, the zigzag symbol in the 

middle of the SatSYNC icon in the icon tray turns green ( ), all the buttons turn white, and the two 

panes are populated accordingly as depicted in Figure 1. Some menu items, namely Create New Folder 

and About My Active 10, remain permanently grey if your Active 10 does not have a combination of 

software version 1.4 or higher and platform version 21 or higher. Chapter 9 explains how you can find 

out the software and platform version numbers on your Active 10. 

1.3 Viewing Actions in Real Time 

When you use the Active 10 to modify routes or OOI, or take screenshots while it is already connected 

to SatSYNC, open the folder where the changes occurred and click on the Refresh button to see changes. 

If routes or OOIs are imported to the Active 10, renamed or deleted via SatSYNC, these actions will only 

appear immediately on an Active 10 running a combination of software version 1.4 or higher and 
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platform version 21 or higher. If your Active 10 does not meet this criterion, the aforementioned actions 

will only take effect once you disconnect your device from your computer and reboot it. 
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2 Import 
There are two types of import buttons. The chapter describes the importing of files from your computer. 

The other type of import which entails transferring directions or shapes from Google Maps to the Active 

10 is described in the chapter 14. 

The following file types are supported: 

 .GPX (routes and POIs) 

 Geocaching.com Pocket Query ZIP files (POIs) 

 .JPG (photos) 

 .KML/.KMZ (routes, POIs and road directions) 

 .LOC (POIs) 

 .MAP from Satmap (routes, POIs and maps) 

 My POI Icons.zip from Satmap (a collection of POI icons) 

 .PNG (16x16 POI icons) 

 Tab delimited text files (routes and POIs) 

 .TCX (tracks) 

 .XOL from swisstopo (tracks) 

2.1 Step by Step Instructions 

Follow these steps to import files to the Active 10: 

1) Click on Import in SatSYNC 

2) Use the file dialog to find your file(s) 

3) Select the file(s) to Import (You can select multiple files by using the Control or Shift Key – see 

http://windows.microsoft.com/en-US/windows7/Select-multiple-files-or-folders for further 

details) 

4) Click on OK or Open 

5) Select the destination – Internal Storage or SD Card 

6) Once the file transfer is complete, the imported file(s) should appear in the current folder 

http://windows.microsoft.com/en-US/windows7/Select-multiple-files-or-folders
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If your Active 10 has a combination of software version 1.4 or higher and platform version 21 or higher, 

you can immediately view any imported routes or OOIs in their respective menus without restarting the 

Active 10. If your Active 10 does not meet this criterion, please follow these steps: 

1) Disconnect the Active 10 from your PC 

2) Press the Power On/Off button on the Active 10 

3) Press the Yes button to confirm 

4) Press the Power On/Off button 

5) Go to the Routes or OOI Menu to view your imported routes or OOIs 

2.2 Tab Delimited Text Files 

You can create routes, AOIs, IOIs, LOIs and POIs in tab delimited text files by using a spreadsheet 

program like Microsoft Excel. These files also allow you to manage existing OOIs and routes more 

effectively: 

 you can easily delete a large number of points 

 you can easily edit text 

 you can merge routes via copy and paste operations 

2.2.1 Create a Route 

If you want to import a route that is in the form of a tab delimited text file, the columns in the file must 

be edited so that they conform to the definitions specified in Row 1 shown in Figure 4. You do not have 

to enter data in Columns A, D and E, but Columns B and C are mandatory. Columns B and C can be in 

Degrees Decimal, British National Grid Easting/Northing1 or British National Grid Reference2 formats; 

in Figure 4, WP4 is in Degrees Decimal, WP3 in British National Grid Reference, and WP2 and WP1 are in 

British National Grid Easting/Northing. 

 

Figure 4: An example of a route in the tab delimited text file format. 

Once you have finished entering your data, you need to save the file as a tab delimited text file and 

import it to the Active 10: 

                                                           
1
 Column B contains the Eastings and Column C contains the Northings 

2
 Column B contains the two grid letters and Column C contains the Eastings and Northings 
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1) In Microsoft Excel, click on File 

2) Click on Save As 

3) In the Saves As window change the Save as type to “Text (Tab delimited)(*.txt)” 

4) Click on Save 

5) Click Yes in the window warning you about compatibility 

6) Close the file [SatSYNC may fail to import the file if it is still open in Microsoft Excel.] 

7) Import the file to the Active 10 using the steps listed in section 2.1 

2.2.2 Create a POI 

If you want to import a POI that is in the form of a tab delimited text file, the columns in the file must be 

edited so that they conform to the definitions specified in Row 1 shown in Figure 6. You do not have to 

enter data in Columns A, D, E, F, G, H, I and J, but Columns B and C are mandatory. Columns B and C can 

be either in Degrees Decimal, British National Grid Easting/Northing3 or British National Grid 

Reference4 formats. Cell A1 must read POI otherwise SatSYNC will import file as a route. If you add the 

characters {br} in the Description Column, a line break will be seen on the OOI Description Screen on the 

device. The Icon Column allows you to specify one of the icons on the device. The full list of pre-installed 

icons is in the appendices. The Images Column allows you to enter the full path of images which are on 

your computer. If you want to put more than one image in your POI, separate the paths with an asterisk 

as shown in Figure 6. 

 

Figure 5: The specification of a POI in a tab delimited text file. 

 

Figure 6: An example of a POI in the tab delimited text file format. 

                                                           
3
 Column B contains the Eastings and Column C contains the Northings 

4
 Column B contains the two grid letters and Column C contains the Eastings and Northings 
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Once you have finished entering your data, you need to save the file as a tab delimited text file and 

import it to the Active 10: 

1) In Microsoft Excel, click on File 

2) Click on Save As 

3) In the Saves As window change the Save as type to “Text (Tab delimited)(*.txt)” 

4) Click on Save 

5) Click Yes in the window warning you about compatibility 

6) Close the file [SatSYNC may fail to import the file if it is still open in Microsoft Excel.] 

2.2.3 Create an IOI 

The procedure for creating IOIs is the same as the one for creating POIs. However, there are some 

differences as illustrated in Figure 7. Cell A1 must read IOI. IOIs also only have three columns, two of 

which, E (Description) and G (Images), are optional. 

 

Figure 7: The specification of an IOI in a tab delimited text file. 

2.2.4 Create an LOI 

The procedure for creating LOIs is the same as the one for creating POIs. However, there are some 

differences as illustrated in Figure 8. Cell A1 must read LOI. Columns D (Elevation) and F (Icon) are not 

applicable to LOIs. In addition, LOIs specify two more optional columns, K and L, for the line style and 

line colour, respectively. There is only one valid line style value at the moment: 1. The valid values for 

the line colour are 0 through 16777215. You can use the decimal value given by the colour mixer at 

http://www.mathsisfun.com/hexadecimal-decimal-colors.html to indicate the colour of your LOI. 

After specifying LOI in cell A1, the second row specifies the LOI reference point (see the Active 10 Full 

User Guide for the definition). The description, images, visibility, style and colour of the LOI must all be 

specified in this row; these attributes are ignored if they are specified in rows other than row 2. The LOI 

points can be specified from rows three onwards. An LOI point only has two attributes: longitude and 

latitude. 

 

Figure 8: The specification of an LOI in a tab delimited text file. 

http://www.mathsisfun.com/hexadecimal-decimal-colors.html
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Figure 9: An example of an LOI in a tab delimited text file. 

2.2.5 Create an AOI 

The procedure for creating AOIs is the same as the one for creating LOIs. However, there are some 

differences as illustrated in Figure 10. Cell A1 must read AOI. Columns K (Line Style) and F (Line Colour) 

are not applicable to AOIs. In addition, AOIs specify two more optional columns, M and N, for the fill 

style and fill colour, respectively. 

The valid fill style values are as follows: 

 0 - for no fill 

 1 - for slanted hatching (bottom left to top right) 

 2 - for slanted hatching (top left to bottom right) 

 3 - for slanted crossed hatching 

 4 - for horizontal hatching 

 5 - for vertical hatching 

The valid values for the fill colour are 0 through 16777215. You can use the decimal value given by the 

colour mixer at http://www.mathsisfun.com/hexadecimal-decimal-colors.html to indicate the colour of 

your AOI. 

 

Figure 10: The specification of an AOI in a tab delimited text file. 

3 Installing Icons 
You can install your own POI icons by going to File → Install Icons. Your icons must meet the 

specifications detailed in section 3.2. You can also download My POI Icons.zip from the Satmap website 

to your computer and then use File → Install Icons if your unit did not come pre-installed with these 

icons. 

http://www.mathsisfun.com/hexadecimal-decimal-colors.html
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3.1 My POI Icons.zip 

The installation of My POI Icons.zip overwrites existing icons with the same name. The default blue 

target is not affected. 

You must install the zip file My POI Icons.zip not the individual icon files inside the zip file. After installing 

the icons, you can see them when creating or editing POIs. Finally, you need to set the appropriate 

options in the OOI tabs on the SatSYNC Settings Window. 

If you would like to modify My POI Icons.zip, you must adhere to these requirements: 

 My POI Icons.zip must contain a folder called My POI Icons 

 The folder My POI Icons must only contain subfolders 

 The icons must be located within the abovementioned subfolders which in turn should not 

contain further subfolders 

 Each icon filename must begin with double underscore “__” 

 If you rename the subfolders or icons, SatSYNC may not be able to automatically assign icons to 

POIs from Geoaching.com and Gipfelbuch.ch 

3.2 Building Your Own Icons 

There are a number of free programs such as Paint and GIMP which you can use to create your own POI 

icons. The strict requirements are that you should save your icons as .PNG files and both the height and 

width must be 16 pixels in size. If you want any areas in your icon to be transparent, you need to fill 

those areas with a purple colour of the value (132, 0, 132) in (R, G, B) format. 

 

http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-us/mspaint_overview.mspx?mfr=true
http://www.gimp.org/downloads/
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4 Export 
The Export button is used for transferring files from the Active 10 to your computer. When you export 

screenshots, icons and .GPX files, they are directly copied to your computer. However, when you export 

.MAP files, you are presented with option to export them as .GPX files, .KMZ, .MAP files or tab delimited 

text files. 

Follow these steps to export files from the Active 10 to your computer: 

1) Select the file(s) and/or folder(s) from either the Folders Pane or the Folders and Files Pane 

2) Click on Export 

3) Use the Browse For Folder dialog to select or create a folder where you want to save your files 

4) Once you have selected the destination folder, click on OK 

5) At least one .MAP file selected: you are present with option export .MAP files as .GPX files, .MAP 

files or tab delimited text files: 

a. .GPX files: choose this option if want to view your routes in Satmap Xpedition 

b. .KMZ files: choose this option if your AOIs/LOIs/POIs have pictures or if you want to view 

your routes or AOIs/LOIs/POIs in Google Earth or Google Maps 

c. .MAP files: choose this option if you simply wish to backup your files since .MAP can be 

copied back to Active 10 more quickly than other route or OOI files 

d. Tab delimited text files: choose this option if you want to manage your routes or OOIs 

(except Grids) in spreadsheet programs such as Microsoft Excel 

4.1 Export your Trip to Google Earth 

You can export your trip log and track to Google Earth. In addition, you can also “play” your track in 

Google Earth. 

At the start of the trip, follow these steps: 

1) Select Reset All from the TRIP LOG MENU (see the 1.5 Active 10 Full User Guide) 

2) Start the Trip Log 

3) Explore the outdoors 

At the end of the trip, do the following: 

1) Stop the Trip Log 

http://www.satmap-xpedition.com/
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2) Select one of Reset All & Convert or one of the other Convert options from the Trip Log Menu 

3) Use SatSYNC to export the converted track, i.e., the .map file 

4) When prompted for the export format, choose KMZ 

5) Drag and drop the KMZ file into Google Earth 

6) Click on the Start or Stop POI to view the Trip Log and Elevation Profile (see Figure 11) 

7) Right-click on the chevron and select Show Elevation Profile to view the speed, elevation, 

distance covered and the time elapsed at any given point on the track (see Figure 12) 

8) Move the mouse to the top left-hand corner and click on the play symbol to play the track (you 

may need to adjust the playing speed if the chevron moves too quickly by clicking on the 

spanner icon) 

 

Figure 11: A trip log exported to Google Earth 
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Figure 12: A track exported to Google Earth. 

 



 

20 | P a g e  
 

5 Right-click Menus 
When the mouse is in any of the two panes in SatSYNC and you press the right button on your mouse, a 

right-click menu will appear. Create New Folder is permanently disabled in the right-click menu for the 

Folders and Files Pane if your unit is not running the combination software version 1.4 or higher and 

platform version 21 or higher. 
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6 Drag and Drop 
Drag and drop operations enable you to quickly transfer files and folders from one location to another 

without clicking on buttons or shortcuts on right-click menus. You can drag files and folders from your 

computer and drop them in the Folders Pane or the Folders and Files Pane in SatSYNC. You can cancel a 

drag and drop operation by press the “Esc” key on your keyboard while the left button on your mouse is 

still pressed. 

6.1 From Your Computer to SatSYNC 

1) Select the items you want to import from a folder on your computer 

2) Initiate a drag & drop operation (see http://windows.microsoft.com/en-US/windows-

vista/Moving-and-copying-files-by-using-the-drag-and-drop-method for further details on drag 

& drop) 

3) Drag the items into the Folders Pane or the Folders and Files Pane in SatSYNC 

6.2 From SatSYNC to Your Computer 

This feature will be available in a future version of SatSYNC. 

6.3 From SatSYNC to SatSYNC 

Dragging items from SatSYNC and dropping them in SatSYNC results in those items being moved or 

copied as indicated in Table 1. 

Source Destination Key Pressed when dropping data Resulting Action 

Internal Storage SD Card 
 

Copy 

Internal Storage SD Card Ctrl Copy 

Internal Storage SD Card Shift Move 

Internal Storage Internal Storage   Move 

Internal Storage Internal Storage Ctrl Copy 

Internal Storage Internal Storage Shift Move 

SD Card Internal Storage 
 

Copy 

SD Card Internal Storage Ctrl Copy 

SD Card Internal Storage Shift Move 

SD Card SD Card 
 

Move 

SD Card SD Card Ctrl Copy 

SD Card SD Card Shift Move 

Table 1: The actions taking place when items are dragged from SatSYNC and dropped in SatSYNC. 

http://windows.microsoft.com/en-US/windows-vista/Moving-and-copying-files-by-using-the-drag-and-drop-method
http://windows.microsoft.com/en-US/windows-vista/Moving-and-copying-files-by-using-the-drag-and-drop-method


 

22 | P a g e  
 

7 Settings 
SatSYNC provides various options related to the way files are imported and exported. 

The Settings Window allows you to set preferences concerning the names of imported routes and OOIs, 

the filtering of route points, the automatic assignment of icons to Geocaching POIs, the export of files, 

the download of data from the Internet, and the suppression of messages. 

Once you have finished selecting your options on a particular tab you can press Apply before continuing 

to another tab. Click on Save if you want to save your changes and do not want to look at other tabs. 

Click on Cancel to cancel any changes which have not been saved or applied. 
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8 About My Active 10 
Help → About My Active 10 displays the following information: 

 Software Version Number 

 Platform Version Number 

 The percentage of Operating Memory or Random Access Memory (RAM) used 

 The percentage of the Internal Storage space used 

 The percentage of the SD Card memory used 

The aforementioned information is only available if your Active 10 has a combination of software 

version 1.4 or higher and platform version 21 or higher. 
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9 Software and Platform Versions 
To find out the software and platform version numbers on your Active 10, proceed as follows: 

1) Go to the Active 10 Main Menu 

2) Press the Settings button 

3) Scroll down to and select About 

4) The platform version number is the number in brackets next to the software version number 

As mentioned in the previous section, if you have a combination of software version 1.4 or higher 

and platform version 21 or higher, you can find also find out the software and platform version 

numbers by clicking on Help → About My Active 10 in SatSYNC. 
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10 Geo-Tag Photos 
The geo-tagging application adds latitude and longitude information recorded by the Active 10 to 

pictures which you have taken with your digital camera. For further details, click on Geo-Tag Photos to 

start the application and then click on User Guide in the Geo-Tag Photos window. 
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11 File Converter 
The file converter has two buttons, Convert to .MAP and Convert from .MAP. They work in a similar way 

to the Import and Export buttons, respectively. However, the File Converter buttons do not need the 

Active 10 to be connected to your computer to work. This is due to the fact the file conversions work on 

files which are already on your computer and the converted files are also left on your computer. 

Therefore, if you are unable to or do not want to connect the Active 10 to your computer with a USB 

cable to transfer files, you can insert an SD Card into your computer’s SD Card reader. You can then use 

Convert from .MAP to “Export” any .MAP files from your SD Card to your computer. You can also use 

Convert to .MAP to “Import” any route and OOI files which are on your computer and save them to the 

SD Card. When you remove the SD Card from your computer and insert it in the Active 10, your new 

routes and POIs are available immediately in their respective menus regardless of the combination of 

software and platform. 

It is also important to note that the Import and Export settings in the SatSYNC Settings Menu control the 

Convert to .MAP and Convert from .MAP settings, respectively. The File Converter uses the language set 

in SatSYNC. Please ensure that your Active 10 is connected to your computer and recognised by SatSYNC 

before you save any SatSYNC Settings which are also used by the File Converter. 
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12 Geocaching 
Geocaching is a high-tech game which involves discovering treasures in the outdoors with the help of 

your GPS device and sharing your experiences online with other geocachers. You can find information 

about different treasures or geocaches at geocaching.com where you can search for geocaches by 

different options such as country, county and post code. 

There are three types of files which you can download from geocaching.com and import to your Active 

10: 

1) LOC Waypoint File: this file only contains the latitude, longitude and name of a geocache 

2) GPX eXchange File: in addition to the information contained in a LOC file, this file contains the 

cache type, size, description, difficulty, terrain, recent logs and hints. SatSYNC also downloads 

pictures if they are available as illustrated in 13. 

3) Pocket Query Zip File: this zip file contains several geocaches which meet your search criteria. 

The zip file can contain either LOC files or GPX files. You can build a pocket query by going to 

“Your Profile” and clicking on “Build Pocket Queries” which is under “Premium Features” 

Please note that you cannot send geocache files to your Active 10 by clicking on “Send to GPS”. You 

need to download the files to your computer and then import them to your Active 10 by using SatSYNC. 

You can find the imported geocaches in the Active 10 OOI Folders. When you have found or not found a 

cache, you can change its icon accordingly through the Edit POI Menu (see the 1.5 Active 10 Full User 

Guide). 

    

http://www.geocaching.com/
http://www.geocaching.com/
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Figure 13: An example of how a Geocaching.com GPX looks on the OOI Description Screen. 
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13 Google Earth 
Google Earth is a free mapping tool which you can use to create your own AOIs, LOIs, POIs and hand-

drawn routes. Google Earth also contains POIs created by other users and it can automatically draw a 

route from specified start and finish locations. All this information can be downloaded as KML or KMZ 

files onto your computer. You then need to use SatSYNC to import these files to your Active 10. You can 

download Google Earth from earth.google.com. Once you have installed Google Earth, double-click on 

the Google Earth shortcut on your desktop to start exploring various features. This section provides a 

few tips on using Google Earth. 

13.1 Find Existing POIs 

To find existing POIs, follow these steps: 

1) Click on the Fly To tab near the top left-hand corner of the Google Earth window (see Figure 14) 

2)  Type the name of a POI, e.g., Kwik-Fit, London 

3) Press Enter on your keyboard 

4) Identify the particular POI you are interested in from the search results or the map 

5) Right click on this POI on the map or search results and click on Save Place As. You can save this 

POI as a KML or KMZ file. If you want to download all the top 10 results, right-click on the folder 

icon next to the text Kwik-Fit, London (1 - 10) at the top of the search results and click on Save 

Place As. 

 

Figure 14: A screenshot of Google Earth 

http://earth.google.com/
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You can search for wide range of existing POIs to arm you with rich information for your trip as 

illustrated in Figure 15. 

 

Figure 15: A wide range of POIs downloaded from Google Earth to the Active 10. 

13.2 Panoramio Photos 

To download a Panoramio Photo: 

1) Right click on the icon  of any photo you like to download 

2) Select Save to My Places 

3) Find your photo in the Places Pane on the left-hand side of the Google Earth window 

4) Right click on the saved photo and select Save Place As … to save it as a KML or KMZ file 



 

31 | P a g e  
 

  

Figure 16: An example of a Panoramio Photo in Google Earth and on the Active 10. 

 

13.3 Create a POI 

To create your own POI: 

1) Click on Add (it is between Tools and Help on the menu strip) 

2) Select Placemark 

3) Do not close the “Google Earth - New Placemark” window, and use the mouse to drag the 

yellow pin to the desired location.  

4) Enter a name and description for this POI in the “Google Earth - New Placemark” window and 

click on OK 

5) Right-click on this POI and select Save Place As to save it as KML or KMZ file 

13.4 Draw a Route/Line 

To draw a route: 

1) Click on Add 

2) Select Path 

3) Do not close the “Google Earth - New Path” window, and move the mouse to the map and 

starting creating your route by clicking on the map 

4) Once you have finished drawing your route, go back to the “Google Earth - New Path” window, 

give the route an appropriate name and select various options such as the colour and thickness 

of the route 
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5) Click on OK. Your route should appear under your search results or My Places. You can then 

right click on it and select Save Place As. 

13.5 Draw an AOI 

1) Click on Add 

2) Select Polygon 

3) Do not close the Google Earth - New Polygon window, and move the mouse to the map and 

starting creating your polygon by clicking on the map 

4) Once you have finished drawing your polygon, go back to the Google Earth - New Polygon 

window, give the polygon an appropriate name and select various options such as the colour 

and thickness of the polygon’s boundary and the fill pattern and colour of the area inside the 

polygon 

5) Click on OK. Your polygon should appear in the Search Results, My Places or Temporary Places. 

You can then right click on it and select Save Place As. 

13.6 Generate Road Directions 

To generate road directions: 

1) Click on the Directions tab 

2) Enter the start and finish locations in the From and To textboxes, respectively, e.g., Heathrow 

Terminal to Heathrow Terminal 2 

3) Press Enter on your keyboard 

4) Once the route has been displayed you can save it as a KML or KMZ file by right clicking on 

“Route” at the bottom of the search results. However, this will not include the turn by turn 

directions. If you would like to have the turn by turn directions in addition to the route on your 

Active 10, you need to right click on the name of the route at the top of the search results, in 

this case Terminal 1, London Heathrow 

5) After you have imported your road directions with turn by turn instructions to the Active 10, 

each route point that has an instruction will display a truncated form of the instruction on the 

map. You can find the full instructions on the Profile page of the route as shown in Figure 17. 
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Figure 17: An example of a route with instructions downloaded from Google Earth. 
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14 Google Maps 
Google Maps is similar to Google Earth, so you can use Google Maps to find existing POIs, create your 

own POIs, create routes/lines and generate road directions. However, there are some key differences 

between the two applications. 

Google Earth is rather limited in providing road directions when compared to Google Maps which 

provides walking, car and public transit directions. In addition, the car directions are provided with the 

option to avoid motorways and tolls, and alternative routes are also suggested for walking and public 

transit directions. Google Maps also allows you to create AOIs, LOIs, and POIs with rich text and pictures. 

SatSYNC has a dedicated function for downloading road directions or shapes from Google Maps as this 

process is very different from downloading items from Google Earth as will be demonstrated in the 

following subsections. 

14.1 Road Directions 

To obtain a KML route file from Google Maps, do the following:  

1) Go to the Google Maps website: maps.google.co.uk 

2) Click on Get Directions  

3) Type the Start address in Textbox A 

4) Type the End address in Textbox B 

5) Click on Get Directions 

6) In the example shown in Figure 18, Google Maps produces three suggested routes. Click on any 

route to view its path on the map.  

7) To download the route as a KML file: 

a. Click on Link (on the top right corner of the map) 

b. Copy the link 

c. In SatSYNC, click on  or File → Import → Directions or shapes from Google Maps 

d. Paste the link in the first textbox 

e. Enter a filename 

f. Click on Import 

http://maps.google.co.uk/
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Figure 18: A screenshot of Google Maps showing walking directions from Waterloo Station to Lambeth North Station 

14.2 Create a Route/Line 

1) Create free account at maps.google.co.uk 

2) Login 

3) Click on My Maps 

4) Click Create a new map 

5) Click on Draw a line or Draw a line along roads 

6) Click on the map to add points to the line 

7) Click on the last point to finish drawing 

8) Enter a name 

9) Click on Rich text 

10) Enter a description 

11) Click on the blue square at the top right-hand corner of the balloon to edit the line’s colour and 

thickness 

12) Click on the picture icon to attach a photo to the description 

13) Once the description is complete click on OK and follow steps in the Google Maps Road 

Directions Section to download the route/line to the Active 10 
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14.3 Create an AOI 

1) Create free account at maps.google.co.uk 

2) Login 

3) Click on My Maps 

4) Click Create a new map 

5) Click on Draw a shape 

6) Click on the map to add points to the line 

7) Click on the last point to finish drawing 

8) Enter a name 

9) Click on Rich text 

10) Enter a description 

11) Click on the blue square at the top right-hand corner of the balloon to edit the colour of the 

polygon’s boundary and area 

12) Click on the picture icon to attach a photo to the description 

13) Once the description is complete click on OK and follow steps in the Google Maps Road 

Directions Section to download the AOI to the Active 10 

14.4 Create a POI 

1) Create free account at maps.google.co.uk 

2) Login 

3) Click on My Maps 

4) Click Create a new map 

5) Click on Add a placemark 

6) Click on the map to add the placemark 

7) Enter a name 

8) Click on Rich text 

9) Enter a description 

10) Click on the picture icon to attach a photo to the description 
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11) Once the description is complete click on OK and follow the steps in the Google Maps Road 

Directions Section to download the POI to the Active 10 
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15 Trouble Shooting 
SatSYNC has upgraded the software on my Active 10, but when I switch on my device it only shows 

Recovery Mode or Fatal Application Error Screen 

Do not worry. Try upgrading again via SatSYNC or through the standalone upgrade program which can 

be downloaded from the Active 10 Software Upgrade section at satmap.com. If this doesn’t work, 

remove the batteries and try again. 

 

The elevation profile on the route or POI I have imported is flat. 

Some mapping tools such as Memory Map produce route or POI files that do not contain any elevation 

data, so this information is not available for the Active 10 to display. 

 

Can I import route or POI files from any mapping tool? 

Although .gpx, .kml, .kmz and .loc files are supposed to be international standards, every provider has a 

slightly different file structure. If SatSYNC fails to convert a file that is in one of the supported formats, 

we encourage you to email that file to customer services. 

 

What is a .map file? 

This file is a modified .gpx, .kml, .kmz or .loc file. By converting to .map, we are simplifying the data and 

focusing on the actual route or POI information. 

 

I have accidentally deleted a file: can I recover this? 

No. Please be very careful that you only delete the correct files.  

 

I have imported a route or POI but I can’t see it on my Active 10. 

If your Active 10 has platform 3 or lower, you need to reboot it, so please unplug it from your PC and 

switch it off and then back on again. 

 

http://www.satmap.com/
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I have rebooted the Active 10, but I still can’t see the imported route. 

You route might have been given a different name (see the Import (1/2) tab in the SatSYNC Settings 

Menu) or it could actually be a series of POIs, so please look for it in the OOI Menu. 

SatSYNC indicates that my route or POI file has been imported successfully, but I cannot see my new 

route or POI after restarting the Active 10. 

Try reducing the number of waypoints or POIs in your original file. Your .map file needs to be less than 

1024 KB.  

 

I cannot see the files I dragged from the Active 10 and dropped onto my memory stick or network 

drive. 

At the moment, SatSYNC does not support the dropping of Active 10 files into removable media or 

network drives. Please use the Export button to transfer files to these locations. 

 

I cannot see the files transferred to or dropped into the SD Card. 

Make sure that your SD Card is not write-protected. Most SD Cards have a tiny switch which must be in 

the “up” position for you to transfer files to it. 

 

I am being asked to confirm the deletion of a particular file when dragging and dropping items from 

SatSYNC to my computer. What should I do? 

Click on Yes to proceed with the drop. 
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Appendices 

15.1 Appendix 1: List of Pre-installed POI Icons 

There are number of pre-installed icons on the Active 10. You can use the following paths to specify 

icons for your POIs created in tab delimited text files. If you installed My POI Icons.zip on your own, 

replace Internal Storage with SD Card if necessary. In addition, if your unit does not have platform 

version 21 or higher, you need to remove the two middle folders, e.g., the first icon would be specified 

as Internal Storage\ __000_Default_Waypoint.png if it is in the Internal Storage. 

Internal Storage\My POI Icons\0.Targets\__000_Default_Waypoint.png 

Internal Storage\My POI Icons\0.Targets\__001_Target_Traditional.png 

Internal Storage\My POI Icons\0.Targets\__002_Target_Multi.png 

Internal Storage\My POI Icons\0.Targets\__003_Filled_Mystery.png 

Internal Storage\My POI Icons\0.Targets\__004_Filled_Multi.png 

Internal Storage\My POI Icons\0.Targets\__004_Filled_Traditional.png 

Internal Storage\My POI Icons\0.Targets\__004_GX_Mystery.png 

Internal Storage\My POI Icons\0.Targets\__005_GX_Multi.png 

Internal Storage\My POI Icons\0.Targets\__005_GX_Traditional.png 

Internal Storage\My POI Icons\0.Targets\__005_Stage of a multicache.png 

Internal Storage\My POI Icons\0.Targets\__006_Target_1.png 

Internal Storage\My POI Icons\0.Targets\__007_Target_2.png 

Internal Storage\My POI Icons\0.Targets\__008_Reference Point.png 

Internal Storage\My POI Icons\1.Spots\__AAA_square_red.png 

Internal Storage\My POI Icons\1.Spots\__AAB_square_blue.png 

Internal Storage\My POI Icons\1.Spots\__AAC_square_green.png 

Internal Storage\My POI Icons\1.Spots\__AAD_square_yellow.png 

Internal Storage\My POI Icons\1.Spots\__AAE_square_purple.png 

Internal Storage\My POI Icons\1.Spots\__AAF_diamond_red.png 
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Internal Storage\My POI Icons\1.Spots\__AAG_diamond_blue.png 

Internal Storage\My POI Icons\1.Spots\__AAH_diamond_green.png 

Internal Storage\My POI Icons\1.Spots\__AAI_diamond_yellow.png 

Internal Storage\My POI Icons\1.Spots\__AAJ_diamond_purple.png 

Internal Storage\My POI Icons\1.Spots\__AAK_spot_red.png 

Internal Storage\My POI Icons\1.Spots\__AAL_spot_blue.png 

Internal Storage\My POI Icons\1.Spots\__AAM_spot_green.png 

Internal Storage\My POI Icons\1.Spots\__AAN_spot_yellow.png 

Internal Storage\My POI Icons\1.Spots\__AAO_spot_purple.png 

Internal Storage\My POI Icons\1.Spots\__AAP_spot_blue_v2.png 

Internal Storage\My POI Icons\1.Spots\__AAQ_spot_green_v2.png 

Internal Storage\My POI Icons\1.Spots\__AAR_spot_red_v2.png 

Internal Storage\My POI Icons\1.Spots\__AAS_orienteering.png 

Internal Storage\My POI Icons\2.Flags\__CCA_flag_red.png 

Internal Storage\My POI Icons\2.Flags\__CCB_flag_blue.png 

Internal Storage\My POI Icons\2.Flags\__CCC_flag_green.png 

Internal Storage\My POI Icons\2.Flags\__CCD_flag_yellow.png 

Internal Storage\My POI Icons\2.Flags\__CCE_flag_purple.png 

Internal Storage\My POI Icons\2.Flags\__CCF_flag_orange.png 

Internal Storage\My POI Icons\2.Flags\__CCG_flag_pink.png 

Internal Storage\My POI Icons\3.Geocaching\__BBA_Found.PNG 

Internal Storage\My POI Icons\3.Geocaching\__BBB_DNF.png 

Internal Storage\My POI Icons\3.Geocaching\__BBC_Traditional Cache.png 

Internal Storage\My POI Icons\3.Geocaching\__BBD_Multi-cache.png 

Internal Storage\My POI Icons\3.Geocaching\__BBE_Earthcache.png 
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Internal Storage\My POI Icons\3.Geocaching\__BBF_Letterbox Hybrid.png 

Internal Storage\My POI Icons\3.Geocaching\__BBG_Cache In Trash Out Event.png 

Internal Storage\My POI Icons\3.Geocaching\__BBH_Event Cache.png 

Internal Storage\My POI Icons\3.Geocaching\__BBI_Webcam Cache.png 

Internal Storage\My POI Icons\3.Geocaching\__BBJ_Virtual Cache.png 

Internal Storage\My POI Icons\3.Geocaching\__BBK_Unknown Cache.png 

Internal Storage\My POI Icons\3.Geocaching\__BBL_GPS Adventures Exhibit.png 

Internal Storage\My POI Icons\3.Geocaching\__BBM_Mega-Event Cache.png 

Internal Storage\My POI Icons\3.Geocaching\__BBO_Project APE Cache.png 

Internal Storage\My POI Icons\3.Geocaching\__BBP_Wherigo Cache.png 

Internal Storage\My POI Icons\3.Geocaching\__BBZ_Parking.png 

Internal Storage\My POI Icons\3.Geocaching\__BCA_Question_to_Answer.png 

Internal Storage\My POI Icons\3.Geocaching\__BCB_Trail Head.png 

Internal Storage\My POI Icons\4.Sports\__blue-ball.png 

Internal Storage\My POI Icons\4.Sports\__bowls.png 

Internal Storage\My POI Icons\4.Sports\__golf-drive.png 

Internal Storage\My POI Icons\4.Sports\__golfball1.png 

Internal Storage\My POI Icons\4.Sports\__golfball2.png 

Internal Storage\My POI Icons\4.Sports\__golfer.png 

Internal Storage\My POI Icons\4.Sports\__sport_basketball.png 

Internal Storage\My POI Icons\4.Sports\__sport_football.png 

Internal Storage\My POI Icons\4.Sports\__sport_raquet.png 

Internal Storage\My POI Icons\4.Sports\__sport_shuttlecock.png 

Internal Storage\My POI Icons\4.Sports\__sport_soccer.png 

Internal Storage\My POI Icons\4.Sports\__sport_tennis.png 
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Internal Storage\My POI Icons\5.Fish\__000_dolphin.png 

Internal Storage\My POI Icons\5.Fish\__000_seahorse.png 

Internal Storage\My POI Icons\5.Fish\__000_starfish.png 

Internal Storage\My POI Icons\5.Fish\__anchor.png 

Internal Storage\My POI Icons\5.Fish\__march-brown.png 

Internal Storage\My POI Icons\5.Fish\__m_sweeny.png 

Internal Storage\My POI Icons\5.Fish\__rainbow.png 

Internal Storage\My POI Icons\5.Fish\__salmon.png 

Internal Storage\My POI Icons\5.Fish\__trout.png 

Internal Storage\My POI Icons\6.Wildlife\__dragonfly.png 

Internal Storage\My POI Icons\6.Wildlife\__elephant.png 

Internal Storage\My POI Icons\6.Wildlife\__horse-head.png 

Internal Storage\My POI Icons\6.Wildlife\__mare.png 

Internal Storage\My POI Icons\6.Wildlife\__meercat.png 

Internal Storage\My POI Icons\6.Wildlife\__panda.png 

Internal Storage\My POI Icons\6.Wildlife\__swallow.png 

Internal Storage\My POI Icons\6.Wildlife\__swifty.png 

Internal Storage\My POI Icons\6.Wildlife\__s_duck.png 

Internal Storage\My POI Icons\6.Wildlife\__thrush.png 

Internal Storage\My POI Icons\7.Flowers\__blue-flower.png 

Internal Storage\My POI Icons\7.Flowers\__buttercup.png 

Internal Storage\My POI Icons\7.Flowers\__clover.png 

Internal Storage\My POI Icons\7.Flowers\__daisy.png 

Internal Storage\My POI Icons\7.Flowers\__maple.png 

Internal Storage\My POI Icons\7.Flowers\__periwinkle.png 



 

44 | P a g e  
 

Internal Storage\My POI Icons\7.Flowers\__poppy.png 

Internal Storage\My POI Icons\7.Flowers\__purple-flower.png 

Internal Storage\My POI Icons\7.Flowers\__red-flower.png 

Internal Storage\My POI Icons\7.Flowers\__rose.png 

Internal Storage\My POI Icons\7.Flowers\__rosebud.png 

Internal Storage\My POI Icons\7.Flowers\__sunflower.png 

Internal Storage\My POI Icons\7.Flowers\__yellow-flower.png 

Internal Storage\My POI Icons\8.Food and Drink\__alcohol_bottle-of-wine.png 

Internal Storage\My POI Icons\8.Food and Drink\__alcohol_glass-of-wine.png 

Internal Storage\My POI Icons\8.Food and Drink\__alcohol_guinness.png 

Internal Storage\My POI Icons\8.Food and Drink\__cup.png 

Internal Storage\My POI Icons\8.Food and Drink\__food.png 

Internal Storage\My POI Icons\9.Transport\__bus.png 

Internal Storage\My POI Icons\9.Transport\__car.png 

Internal Storage\My POI Icons\9.Transport\__coach.png 

Internal Storage\My POI Icons\9.Transport\__cycle.png 

Internal Storage\My POI Icons\9.Transport\__ferry.png 

Internal Storage\My POI Icons\9.Transport\__gas.png 

Internal Storage\My POI Icons\9.Transport\__helicopter.png 

Internal Storage\My POI Icons\9.Transport\__jet.png 

Internal Storage\My POI Icons\9.Transport\__land-rover.png 

Internal Storage\My POI Icons\9.Transport\__liner.png 

Internal Storage\My POI Icons\9.Transport\__lorry.png 

Internal Storage\My POI Icons\9.Transport\__puffer.png 

Internal Storage\My POI Icons\9.Transport\__railtrain.png 
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Internal Storage\My POI Icons\9.Transport\__ship.png 

Internal Storage\My POI Icons\9.Transport\__spanner.png 

Internal Storage\My POI Icons\9.Transport\__taxi.png 

Internal Storage\My POI Icons\9.Transport\__tram.png 

Internal Storage\My POI Icons\9a.Arrows\__arrow_branch.png 

Internal Storage\My POI Icons\9a.Arrows\__arrow_divide.png 

Internal Storage\My POI Icons\9a.Arrows\__arrow_down.png 

Internal Storage\My POI Icons\9a.Arrows\__arrow_in.png 

Internal Storage\My POI Icons\9a.Arrows\__arrow_join.png 

Internal Storage\My POI Icons\9a.Arrows\__arrow_left.png 

Internal Storage\My POI Icons\9a.Arrows\__arrow_merge.png 

Internal Storage\My POI Icons\9a.Arrows\__arrow_out.png 

Internal Storage\My POI Icons\9a.Arrows\__arrow_redo.png 

Internal Storage\My POI Icons\9a.Arrows\__arrow_right.png 

Internal Storage\My POI Icons\9a.Arrows\__arrow_turn_left.png 

Internal Storage\My POI Icons\9a.Arrows\__arrow_turn_right.png 

Internal Storage\My POI Icons\9a.Arrows\__arrow_undo.png 

Internal Storage\My POI Icons\9a.Arrows\__arrow_up.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__basket.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__bell.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__bergportal_gipfel.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__binoculars.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__boating.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__book.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__brolly.png 
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Internal Storage\My POI Icons\9b.Miscellaneous\__building.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__camera2.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__campfire.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__campgrd.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__casino.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__catscale.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__cemetery.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__clock.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__cross.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__crossing.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__danger.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__doctor.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__eye.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__film.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__find.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__foot_steps.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__govbldg.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__heart.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__help1.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__help2.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__hiking.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__home.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__information.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__keltic.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__key.png 
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Internal Storage\My POI Icons\9b.Miscellaneous\__keylock.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__lightning.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__magnify.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__mobile-phone.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__mortar.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__music.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__prop.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__rainbow.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__red_cross.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__scroll.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__shovel.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__signpost.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__star.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__sterling.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__sun.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__telephone.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__tent.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__tick.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__trolley.png 

Internal Storage\My POI Icons\9b.Miscellaneous\__zzzEmptyImage.png 
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